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Important Notice

Copyright
© 2001, 2002 Agilent Technologies. All rights reserved. 

Portions of the software copyright © Chris Maunder, 1998.

No part of this manual may be reproduced in any form or 
by any means (including electronic storage and retrieval 
or translation into a foreign language) without prior 
agreement and written consent from Agilent Technologies 
Inc. as governed by United States and international 
copyright laws. 

Author: Anja Schauer, t3 medien GmbH

Notice
The material contained in this document is subject to 
change without notice. Agilent Technologies makes no 
warranty of any kind with regard to this material, 
including, but not limited to, the implied warranties of 
merchantability and fitness for a particular purpose. 
Agilent Technologies shall not be liable for errors 
contained herein or for incidental or consequential 
damages in connection with the furnishing, performance, 
or use of this material.

ATTENTION: Use of the software is subject to the Agilent 
Software License Terms set forth below. Using the 
software indicates your acceptance of these license terms. 
If you do not accept these licence terms, you may return 
the Software for a full refund. If the Software is bundled 
with another product, you may return the entire unused 
product for a full refund. 

AGILENT SOFTWARE LICENSE TERMS
The following License Terms govern your use of the 
accompanying Software unless you have a separate signed 
agreement with Agilent.

License Grant. Agilent grants you a license to use one 
copy of the Software. "Use" means storing, loading, 
installing, executing or displaying the Software. You may 
not modify the Software or disable any licensing or control 
features of the Software. If the Software is licensed for 
"concurrent use", you may not allow more than the 
maximum number of authorized users to use the Software 
concurrently.

Ownership. The Software is owned and copyrighted by 
Agilent or its third party suppliers. Your license confers no 
title to, or ownership in, the Software and is not a sale of 
any rights in the Software. Agilent's third party suppliers 
may protect their rights in the event of any violation of 
these License Terms.

Copies and Adaptations. You may only make copies or 
adaptations of the Software for archival purposes or when 
copying or adaptation is an essential step in the authorized 
Use of the Software. You must reproduce all copyright 
notices in the original Software on all copies or 
adaptations. You may not copy the Software onto any 
public network.

No Disassembly or Decryption. You may not 
disassemble or decompile the Software unless Agilent's 
prior written consent is obtained. In some jurisdictions, 
Agilent's consent may not be required for limited 
disassembly or decompilation. Upon request, you will 
provide Agilent with reasonably detailed information 
regarding any disassembly or decompilation. You may not 
decrypt the Software unless decryption is a necessary part 
of the operation of the Software.

Transfer. Your license will automatically terminate upon 
any transfer of the Software. Upon transfer, you must 
deliver the Software, including any copies and related 
documentation, to the transferee. The transferee must 
accept these License Terms as a condition to the transfer.

Termination. Agilent may terminate your license upon 
notice for failure to comply with any of these License 
Terms. Upon termination, you must immediately destroy 
the Software, together with all copies, adaptations and 
merged portions in any form.

Export Requirements. You may not export or re-export 
the Software or any copy or adaptation in violation of any 
applicable laws or regulations.

U.S. Government Restricted Rights. The Software and 
any accompanying documentation have been developed 
entirely at private expense. They are delivered and 
licensed as "commercial computer software" as defined in 
DFARS 252.227-7013 (Oct 1988), DFARS 252.211-7015 
(May 1991) or DFARS 252.227-7014 (Jun 1995), as a 
"commercial item" as defined in FAR 2.101(a), or as 
"Restricted computer software" as defined in FAR 52.227-
19 (Jun 1987)(or any equivalent agency regulation or 
contract clause), whichever is applicable. You have only 
those rights provided for such Software and any 
accompanying documentation by the applicable FAR or 
DFARS clause or the Agilent standard software agreement 
for the product involved.
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The Agilent E2976A SVP Window

The Agilent E2976A SVP window is the user interface for setting up and 
running system tests. It is always visible while the application is running. 
The Agilent E2976A SVP window consists of a menu bar, a toolbar, a 
navigator with shortcut menus, a dialog frame and a status bar.

Menu Bar The different menus in the menu bar give you access to most of the SVP 
functions. The functions unique to SVP are explained in “Menus” on 

page 7. 

Toolbar The toolbar gives you quick access to the most commonly used 
functions. These are explained in “Menus” on page 7.
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The Agilent E2976A SVP Window
Navigator The navigator helps you find through your defined test structure and 
open the corresponding dialog windows. All dialog windows are 
explained in “Windows” on page 17. 

In addition, shortcut menus give you quick access to the features that are 
valid for the selected item. The items in the shortcut menus are 
explained in “Menus” on page 7.

Dialog Frame The dialog frame shows the selected dialog windows that are explained 
in “Windows” on page 17.

Status Bar The status bar gives information about the current operation mode and 
shows how to get online help.
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Menus

This section describes the features that are unique to the SVP 
application. All features are accessible within the menus in the menu bar 
or within the shortcut menus in the navigator. 
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Menus File Menu
File Menu

The File menu items can be used to run file handling actions, and to run 
and stop tests and entire SVP objects.

Features Unique to SVP The File menu contains standard desktop features and features unique to 
the SVP application, such as:

• Open 

To load a previously saved session, click this item. The session file 
(VPS file) can then be selected from the Open File dialog box.

• Run 

To run the current scenario or the entire SVP object, click this item. 
Note that before you click the Run item, ensure that you are in online 
mode, and that at least one scenario has been configured. 

For quick access, click the Run icon  in the toolbar or use the 
shortcut menus. 

While the test is running, the test report is generated. The test report 
gives information about the test results. For further information on the 
test report, refer to “SVP Reporting Dialog Box” on page 13.

• Stop 

To stop the running scenario or SVP object, click this item. For quick 
access, click the Stop icon  in the toolbar or use the shortcut 
menus. 

NOTE You cannot continue a stopped test. 

• Print … 

To print the static report, click this item. The static report contains 
information about the test configuration. For further information on 
the static report, refer to “SVP Reporting Dialog Box” on page 13.
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Edit Menu Menus
Edit Menu

The Edit menu can be used to apply changes and to configure the test 
architecture. 

• Apply 

To apply changes in test configuration settings, use this item. For 
quick access, click the Apply icon  in the toolbar.

In both cases you will be asked via a dialog box if the changes should 
be applied.

Select … You can use the Select commands to select available tests for scenarios 
and available cards for tests. These commands are also available within 
the shortcut menus. Clicking on these commands opens the “Select from 

Available Items Dialog Box” on page 11.

• Select Test(s) 

To select an available test for the current scenario, use this item. 

• Select Card(s) 

To select an available card for the current test, use this item. 

Insert … You can use the Insert commands to insert new scenarios, new tests and 
new cards in the navigator. These commands are also available within 
the shortcut menus.

• Insert New Scenario 

To insert a new scenario in the current SVP object, use this item. 

• Insert New Test 

To insert a new test in the Tests Available item, use this item. 

• Insert New Card 

To insert a new card in the Cards Available item, use this item. This 
feature is only available in offline mode. In online mode, cards are 
inserted automatically.
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Menus Edit Menu
Remove … You can use the Remove commands to remove current scenarios, 
available tests and available cards from the navigator. 

• Remove Scenario 

To remove the selected scenario, use this item. The last scenario in the 
navigator cannot be removed.

For quick access, use the shortcut menu of the Scenario item in the 
navigator. 

• Remove Test 

To remove a test from the Tests Available container, click this item. 
For quick access, use the shortcut menu of the test item in the 
navigator.

• Remove Card 

To remove a card from the Cards Available container, click this item. 
In online mode, cards connected to the system under test cannot be 
removed. For quick access, use the shortcut menu of the testcard item 
in the navigator.
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Edit Menu Menus
Select from Available Items Dialog Box
This dialog box is opened when you click one of the Select commands. It 
shows all available tests or cards and the ones already selected. 

Select From Available Cards The dialog box for selecting testcards is shown in the figure below. The 
dialog box for selecting tests looks similar but contains no Selection 
group.

Selection Group Min and Max show the minimum and maximum number of testcards that 
can be used for the respective test.

Distribution Arrows You can move particular components from one container to the other by 
using the distribution arrows or by double-clicking the respective 
component. 

Multiple components can be moved by using the Ctrl and Shift keys.

Selection 
Group

Distribution 
Arrows
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Menus View Menu
View Menu

The View menu items can be used to switch the Toolbar or Status Bar on 
or off, to view reports and to set program options.

Features Unique to SVP The View menu contains standard features and features unique to the 
SVP application, such as:

• Static Report …

To view the static report, use this item. Clicking this item opens the 
“SVP Reporting Dialog Box” on page 13.

• Test Report …

To view the test report, use this item. The test report contains the 
status and the results of testing. As soon as the testing takes place 
(after clicking the Run item), the information is added to the report in 
defined time intervals. Clicking this item opens the “SVP Reporting 

Dialog Box” on page 13.

• Cardlog 

To get information about the connection established to the testcard 
currently selected, use this item. Clicking this item opens the “SVP 

Reporting Dialog Box” on page 13.

• Options … 

To switch the auto-save option on or off, or to modify the time span 
format, click this item. That opens the “SVP Options Dialog Box” on 

page 15.
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View Menu Menus
SVP Reporting Dialog Box
The SVP Reporting dialog box shows the static report, the test report or 
the cardlog. 

SVP Reporting View Menu You can switch between the different reports by checking the respective 
items in the SVP Reporting View menu. 

You can make the SVP Reporting dialog box always visible on top of the 
screen by checking the Always on Top item.

Static Report The static report is generated after the setup has been finished and 
before any actual testing takes place.

This report gives information about:

• Software 

Version, build number or DLL versions.

• System configuration 

Operating system, number of processors, number of busses.

NOTE You can add items unknown to the SVP application in the static report 
(for example, system name, system state).

• Testcard configuration

Number of cards, types of cards, firmware version(s), possibly serial 
numbers to uniquely identify cards.

• Test setup and the number of scheduled tests
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Menus View Menu
Test Report The test report gives information about:

• Date and time

• Testcard status

• System status

• Test data 

Addresses, block sizes, estimated testing times.

• Progress information 

Elapsed time, tests finished or tests to go.

• Performance and metrics

View Cardlog The cardlog report informs about the connection established to the 
testcard. If errors occur on the testcard, the respective function that 
noticed the error will be listed here. 
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View Menu Menus
SVP Options Dialog Box
You can modify general options and define the directories where all files 
used in the test session can be stored.

General Options You can get access to the general options by clicking the Options tab.

• Auto-save Objects

If selected, all changes in test configuration settings immediately are 
valid. If not selected, you can apply changes by 

– clicking into the navigator, or 

– clicking the Apply icon  in the toolbar, or 

– by opening the Edit menu in the menu bar and selecting Apply. 

In all this cases you will be asked via a dialog box if the changes 
should be applied.

• Time Span Format

The time span format is used to set all time definitions of your current 
session. 

Directories You can get access to the directories by clicking the Directories tab. 

You can select the directories where card settings (VPS files), reports 
(RPT files) and generated waveforms (WFM files) can be stored. Clicking 
the details button next to the selected data path allows you to browse.
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Menus Mode Menu
Mode Menu

The Mode menu can be used to switch between online and offline mode.

• Go Online 

To switch on the connection to the system under test, click this item. 
The online mode allows you to run the testing and to generate a test 
report. For detailed information on the test report, refer to “SVP 

Reporting Dialog Box” on page 13. For quick access to the online 
mode, click the icon  in the toolbar. 

• Go Offline 

To switch off the connection to the system under test, click this item. 
The offline mode allows you to configure the testing without using any 
testcard. For quick access to the offline mode, click the icon  in 
the toolbar.

Help Menu

The Help menu items can be used to get information about the entire SVP 
application or about specific problems. 

A Guided Tour helps you to familiarize with the commonly used features 
of the SVP application. Clicking this item leads you through all steps of 
setting up an entire SVP object.
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Windows

This section describes all windows used to set up a test session.

SVP Object Window

The SVP Object window is displayed by clicking the SVP item in the 
navigator. This window contains edit fields to identify the entire test 
object and shows the configured scenarios, the available tests and the 
available testcards. You can get further information by double-clicking 
on the respective objects. 

In addition, the SVP object window allows you to view the test report 
and modify settings that affects the static report, card identification and 
test behavior on error.

• View Log … 

Opens a text edit window that shows the test report. For further 
information on the test report, refer to “SVP Reporting Dialog Box” on 

page 13.

• Settings … 

Opens the SVP Test Settings Dialog Box to set an action (stop or 
continue) on error, to define the card identification and to select the 
extent of the static report. 
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Windows SVP Object Window
SVP Test Settings Dialog Box
The SVP Test Settings dialog box contains the drop-down list boxes for 
selecting general test settings and check boxes to define the contents of 
the static report. In this dialog box, you can find the following elements:

• ID Cards By 

The settings for each testcard are assigned to a configured testcard 
name. These settings contain the following information to identify the 
corresponding physical testcard: the type of connection, the serial 
number, the bus location and the model number. All this information 
will be stored in the settings file. 

If you use the settings file from a previously configured test for 
another system under test, the software assigns the previously 
configured testcard names to the physically available testcards. 

ID Cards By determines the criterion used to identify the matching 
testcard for each testcard name. For example, if you select Serial 
Number, SVP will look for the testcards whose serial numbers match 
the ones stored in the settings file. 

Testcards that are connected to more than one port (for example, PCI 
and RS-232) are always searched in the order of their fastest 
connection.

• On Error 

In this drop-down list, you can define whether the tests stop or 
continue after an error. Errors can be protocol violations, data 
compare errors, or master abort conditions.

ID Cards By Testcards are assigned according to the 

Connection external connection (for example, COM 1, COM 2, …)

Serial Number serial number

Location (Bus/Slot) location in the bus configuration

Model Number model numbers
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Tests Available Window Windows
Reports You can show specific information in the static report by selecting the 
following check boxes:

• Software Info. 

SW version, build number, DLL versions

• System Info.

Operating system, number of processes, number of busses

• Scenario 

Number of scenarios, tests implemented in the scenarios

• Test 

Number of tests, test configuration

• Testcard 

Testcard configuration

Tests Available Window

The Tests Available window is displayed when clicking the Tests 

Available item in the navigator.

This window shows function, start time, duration and the used testcards 
of all defined tests of the current session. 

To modify properties or to get detailed information about an available 
test, double-click on the particular component to open the 
corresponding Test Setup window. 
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Windows Cards Available Window
Cards Available Window

The Cards Available window is displayed when clicking the Cards 

Available item in the navigator.

This window gives information on the testcards and shows where they 
are installed on. 

To modify properties or to get detailed information about an available 
card, double-click on the particular component to open the 
corresponding Testcard Setup window.

Scenario Details Window

The Scenario Details window is displayed when clicking the Scenario 
item in the navigator.

The Scenario Details window shows all tests integrated in the current 
scenario with their functions and durations. You can also insert new tests 
here. The Scenario Details window also shows the Name and the Total 

Duration. 

Name and Total Duration In the Name field you can enter a new name for the scenario. This name 
will then appear in the navigator immediately. The total duration is the 
maximum period of time that results from the sum of start delay and 
duration defined in the Test Setup window.

Select Test(s) Button To insert an available test in the current scenario, click the Select Test(s) 

button. That opens the “Select from Available Items Dialog Box” on 

page 11.

To modify test properties or to get detailed information about the used 
tests, double-click on the selected component in the Scenario Details 
window to open the corresponding Test Setup window.
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Test Setup Window Windows
Test Setup Window

The Test Setup window is displayed when clicking a test item in the 
navigator. The Test Setup window allows you to set up a test by selecting 
test properties and to insert cards. This window also gives information 
about the cards used by the specified test. 

Name and Description The following items are optional: 

• Name 

You can modify the name of the current test. The name will be valid 
for all further actions in the current session. 

• Description 

You can enter a short description of the current test. This entry will 
appear in the static report.

Test Properties The test properties are:

• Function 

You can select one of the predefined test functions busload, 
card2sysmem, configscan, cpu2card, cpucard2sysmem, 
master2target, peer2peer, protocolcheck and sysmemread from the 
selection list.

You can find information about the selected test below the selection 
list.
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Windows Test Setup Window
• Address (Space/Offset) 

The address space you have to select from the selection list depends 
on the selected test function. MEM is default.

You can enter an offset in the edit field. The default value is 000B8000\h.

Test Function Possible Address Space

busload MEM (default) or IO

card2sysmem MEM (default)

configscan not available

cpu2card MEM (default) or IO

cpucard2sysmem not available

master2target MEM (default) or IO 

peer2peer MEM (default) or IO

protocolcheck not available

sysmemread MEM (default) 

card2sysmemuser MEM (default)

cardtest MEM (default)

posttest not available

MCT Test not available

Interrupt Test not available

cpu2card_card2sysmem MEM (default)
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Test Setup Window Windows
• Start Delay (<Time Span Format>) 

The delay time starts when the scenario in which the test is integrated 
begins to run. See the timing in the figure below.

The predefined time span format can be modified by selecting Options 
in the View menu.

• Duration (<Time Span Format>)

The duration time defines how long the current test will run.

• Bytes to Transfer 

You can enter an integer number of bytes to be transferred in the 
range 1 … 29. The default value is 4096. 

If the duration time is longer than the time needed to transfer the 
specified bytes, the testing restarts. If the duration time is shorter than 
the time needed to transfer the specified bytes, the transfer will not be 
completed. The elapsed time is displayed in the Scenario Details 
window.

• Bandwidth 

Requested bus bandwidth in percent. You can enter the bandwidth in 
the range 1 … 100 or move the slider to specify the value. The test tries 
to occupy the bus with this bandwidth. 

The default value is 100.

Scenario 1

SVP object

Test 2

Test 3

Test 1
Start Delay 1

Duration Test 3

Time

Scenario 2

Test 2

Test 1
Start Delay 1

Test 5
Start Delay 5

Duration Test 5
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Windows Testcard Setup Window
Select Card(s) Button To insert a new card in the current test, click the Select Card(s) button. 
That opens the “Select from Available Items Dialog Box” on page 11.

Extended Options Button To choose various test options for some PCISIG tests, click the Extended 

Options button. This opens the respective “Card Settings Dialog Boxes 

for Test Setup” on page 27.

Cards Selected The Cards Selected container gives information about the cards used by 
the defined test. A double-click on a selected testcard opens the 
“Testcard Setup Window” on page 24.

Testcard Setup Window

The Testcard Setup window is opened by clicking a testcard item in the 
navigator. The Testcard Setup window gives information about the 
testcard and the PCI/PCI-X bus it is plugged into. This window also 
allows you to modify card settings. 

Testcard Info The Testcard Info group contains product and installation identifiers. 
These entries cannot be modified in online mode. They are determined 
by the current card and its installation. 

Binary Code The SVP application is searching the testcards after the criterion defined 
in ID Cards By (see “SVP Test Settings Dialog Box” on page 18). The 
number assigned for every card is displayed as binary code next to the 
Name edit field. 

Card Operations Buttons There are several buttons to perform testcard operations:

• Reset Card 

Clicking this button allows you to reset the testcard to the factory 
defaults. The settings are used the next time the card is rebooted. 

NOTE The testcard is unusable prior to rebooting.

• Ping Card 

Clicking this button checks the connection to the testcard by calling a 
ping function (causes green and red LEDs on the testcard to flash). A 
ping box will report any connection errors.
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Testcard Setup Window Windows
• Cardlog ... 

Clicking this button opens the SVP Reporting dialog box and informs 
about the connection established to the testcard. For further 
information on the cardlog report, see “SVP Reporting Dialog Box” on 

page 13. 

Settings The Settings group contains several check boxes used to enable or 
disable the current card features in online and offline mode. Switching 
off the features that are not necessary for your test configuration results 
in shorter run times. 

Details buttons  next to several check boxes allow you to view the 
card properties that can be modified for your specific test. For more 
information about single testcard parameters, please refer to Testcard 

Parameters in the Agilent E2976A System Validation Package User’s 

Guide (pdf-file). 

The check boxes are:

• Use PPR 

To generate protocol permutations for transactions, this check box 
must be selected. If not selected, the PCI/PCI-X Exerciser uses always 
fixed values for the properties. Clicking the Use Master and Use 

Target details buttons displays the available properties.

• Use Master 

To execute the sysmemread, card2sysmem, cpucard2sysmem, 
peer2peer tests, this check box must be selected. For the 
master2target test, this check box also must be selected, if the 
testcard acts as the master. Clicking the details button next to this 
check box, opens the “Card Settings Dialog Box” on page 27 to check 
the master attributes. 

• Use Target 

To execute the tests cpu2card and peer2peer, this check box must be 
selected. For the master2target test, this check box also must be 
selected, if the testcard acts as the target. Clicking the details button 
next to this check box, opens the “Card Settings Dialog Box” on 

page 27 to select the target attributes.

• Use Performance 

To run the performance counters, this check box must be selected. As 
a result, the performance values efficiency, throughput and utilization 
are listed in the test report.
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Windows Testcard Setup Window
• Inhibit FSI 

This check box inhibits the Front Side Interface Executable (FSI 
Executable). 

To enable external control for the card2sysmem, cpu2card, 
cpucard2sysmem and configscan tests, this check box must not be 
selected. For sysmemread, peer2peer, master2target, protocolcheck 

and busload, this check box can be selected. 

• Use Protocol Checker (Rule Masking)

To execute the protocol checker, this check box must be selected. 
Clicking the details button next to this check box, opens the “Protocol 

Rule Masking Dialog Box” on page 32 that allows you to enable and 
disable protocol rules. 

• Use Analyzer 

The following check boxes are only available when the Use Analyzer 
check box is selected.

– Trigger I/O Lines 

To enable cross-triggering with the test or to connect an external 
logic analyzer, this check box must be selected. Cross-triggering 
means, that you connect the trigger I/O ports of two testcards. 

– Upload Trace on Trigger 

To write the trace memory from the testcard to a WFM file (default 
is tracemem) after the testing is triggered, this check box must be 
selected. The trace memory waveform file can be used for in-depth 
root cause analysis. This option usually is not recommended, 
because it can take very long time to complete.

To change the name or the directory where the file should be 
stored, click the details button next to the File edit field.

Set Defaults Button Clicking this button sets all card properties in the GUI to default values. 
For default values, please refer to the Agilent C-API/PPR Programming 

Reference which is delivered with the testcard.
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Testcard Setup Window Windows
Card Settings Dialog Box
The Card Settings dialog box opens when you:

• Click the Extended Options button in the Test Setup window. 

The Card Settings dialog box is only available for some SIG tests. The 
Card Settings dialog box for various test options is described below.

• Click the details buttons of the Use Master and Use Target check 
boxes in the Testcard Setup window. 

See “Card Setting Dialog Box for Testcard Setup” on page 29 for 
more information. 

Card Settings Dialog Boxes for Test Setup
The appearance of the Card Settings dialog box depends on the selected 
SIG test.

The Card Settings dialog box allows you to choose various options for 
the following SIG tests:

• SIG Cardtest

You can define the card to be tested by its device number. You can also 
define the power management state delay for the power management 
test included in the SIG Cardtest. The valid values for the delay (in ms) 
are 100 … 10000. 
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Windows Testcard Setup Window
• SIG Posttest

You can define the location, the type and the size of the BAR decoders, 
and the relevant bits and the values of the command register.

• SIG Interrupt routing test

You can define a particular interrupt line.
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Testcard Setup Window Windows
Card Setting Dialog Box for Testcard Setup 
The appearance of the Card Settings dialog box depends on whether you 
use PCI or PCI-X testcards: 

• For PCI testcards, this dialog box contains a table with all available 
master or target properties and a button for syntax checking. 

• For PCI-X testcards, this dialog box contains a table with all available 
requester or completer properties and a button for syntax checking. 

Master Properties If the Use PPR check box in the Testcard Setup window is selected, the 
dialog box contains both properties used to permutate master attributes 
and invariable master properties.

Target Properties If the Use PPR check box in the Testcard Setup window is selected, the 
dialog box shows the properties used to permutate target attributes. 
There are no invariable target properties.
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Windows Testcard Setup Window
Requester Properties If the Use PPR check box in the Testcard Setup window is selected, the 
dialog box contains both properties used to permutate requester 
behaviors and invariable requester properties.

Completer Properties If the Use PPR check box in the Testcard Setup window is selected, the 
dialog box shows the properties used to permutate completer behaviors. 
There are no invariable completer properties.

Check Syntax Button Clicking the Check Syntax button opens the Check Syntax dialog box. 
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Check Syntax Dialog Box
Clicking the Check Syntax button in the Card Settings dialog box opens 
the Check OK dialog box, assuming that no errors occurred during 
program execution. Otherwise a Check Failed dialog box displays the 
occurred errors.

The content of the Check OK dialog box differ for PCI and PCI-X 
testcards: 

• For PCI testcards, this dialog box contains a PCI Protocol Permutator 
and Randomizer software report with the results of the executed 
testing. 

The individual sections of the report are explained in detail in the 
Agilent C-API/PPR Programmer’s Guide, which is delivered with the 
PCI testcard.

• For PCI-X testcards, this dialog box contains a PCI-X Protocol 
Permutator and Randomizer software report with the results of the 
executed testing. 
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Protocol Rule Masking Dialog Box
The content of the Protocol Rule Masking dialog box differ for PCI and 
PCI-X testcards: 

• For PCI testcards, this dialog box lists all protocol rules defined by the 
PCI specification and some Agilent rules (see the Agilent C-API/PPR 

Reference, which is delivered with the PCI testcard). 

• For PCI-X testcards, this dialog box lists all protocol rules defined by 
the PCI-X specification and some Agilent rules (see the Agilent 

C-API/PPR Programming Reference, which is delivered with the 
PCI-X testcard). 

The following figure shows the Protocol Rule Masking dialog box for 
PCI-X protocol rules as an example.

Each testcard has a protocol observer that monitors the PCI or the PCI-X 
bus in real time to detect any protocol violations. This dialog box allows 
you to enable and to disable protocol rules. 

Enable or Disable all Rules You can enable or disable all rules listed anywhere in the table by 
clicking the respective button. A right-click in the rule table will open a 
shortcut menu, where you can also select these features. 

Enable or Disable one Rule You can enable or disable a selected rule by using the shortcut menu, 
which is available by right-clicking in the rule table. Clicking in the state 
column of the selected rule will change the current state of this rule.
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Rule Description You can get detailed information by selecting Rule Description in the 
shortcut menu of a selected rule. Clicking on the rule identifier will also 
show the description of the selected rule.

For example, if you click on IRDY 0, the following description is shown:

Rule Masking after a Specified
Number of Occurrences

The Protocol Rule Masking dialog box allows you to mask rules after a 
specified number of occurrences, so that storage of identical rule 
violations in the test report is limited. The number can be entered in the 
Mask Rule(s) After x Occurrences field.

Protocol Rules SEM8, SEM9, LAT0
Violations of these rules are known to be caused by 

• the E2920 series testcards whenever they are connected via PCI port

• using the FSI-Executable

To detect potential problems with these rules caused by other cards that 
have this problem, use an external connection and inhibit FSI. To inhibit 
FSI, select the respective check box in the Testcard Setup window. 
Otherwise, these rules can be masked out.
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